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1 IntrOductlon an ideagen product

1.1 Overview

This manual contains instructions on installing, configuring, maintaining and troubleshooting the
integration between the PleaseReview document review server and CARA, when used in conjunction
with Documentum Server.

Note that the development name for the PleaseReview product is “Tara”. This name is not visible to the
end user but when administering the system at the Operating System level; you will see this is reflected
in the names of some files, directories, configuration entries etc.

1.2 Upgrading from an earlier version of PleaseReview

If you are upgrading from a previous version of PleaseReview, you will first need to patch the
PleaseReview Server and PleaseReview Documentum Remoting Layer, in addition to reconfiguring the
PleaseReview Documentum System Connector so they are all at the same new patch level.

Please note that PleaseReview 6.6.7 and later supports Documentum Server version 7.2 up to 16.4

with Java Documentum Remoting Layer. The WCF Documentum Remoting Layer will still work for
Documentum Server version 7.1 and earlier.

1.2.1 Upgrade version number
You then need to reset the internal PleaseReview version number within CARA to match that of the
upgraded release.

To do this, use the CARA interface, logging in as an Administrator, and open the Control Panel. On
the Data tab, press the Dictionaries button, which will open the Dictionary Manager form. To
update the version number, select PleaseReviewConfigSettings inthe Dictionary Manager
form and then press Edit. The below screen will appear:

Dictionary: PleaseReviewConfigSettings |E||z|
Search: | |x |
Active? Value = Setting Code Description
PleaseReviewBasaURL The base URL for the -

corresponding instance of
PleaseReview {e.0.
https:\kldev.pleasetech.ne...

Version 6.4.4 The release number of the
PleaseReview CARL
Component
@ Add ' Edit m Remove Export to... ~ Import D Populate with DQL
Save Close

Next, highlight the value version and press Edit. Inthe Setting Code field enter the new
versionnumber for your patched PleaseReview instance.

1.2.2 Changes made at Version 6.2
If you are upgrading PleaseReview from 6.2 or later to 7.x, you may skip this section.
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If you are upgrading PleaseReview to 6.x from a version of an ideagen product
PleaseReview prior to 6.2, you will need to make additional changes. Extract the provided zip file
(PleaseReview_CARA_UI_xxx.zip) into a temporary directory and use it to make the required Cara
configuration changes, as listed:

¢ Create a new DocBase role cara pleasereview admin, using the DQL statements provide in
section PleaseReview DocBase Roles.

e Repeat the PleaseReview icon installation in section Installing the PleaseReview icons.

e Update the custom action code by repeating the step in section Custom Code by replacing the
existingJSP files.

e Create the two new custom actions "New Review as PDF (with documents)”and
“Workgroup Administration”and recreate the “Review Control Panel” custom action, as
per the instructions in section Custom Actions.

e Create a new Snaplist "a11 Reviews (Admin)”, as per section Installing the PleaseReview custom
configuration.

e Create a new menu item "New Review as PDF (with documents)”, as per section Menu.

e Create a new toolbar items "New Review as PDF (with documents)”and “Workgroup
Administration”, as per section Toolbar.

e Recycle the CARA Web Server, as per section Recycle CARA Web Server.

e Assign any admin users to the base sync work, as per section Groups for locked workgroups.
Then perform a user sync and set their workgroup role via the PleaseReview Admin screens to
include admin. Finally addthem to the DocBase role cara pleasereview admin to enable
the Workgroup Administration features.

1.2.3 Upgrade Tests
You should now test the system as outlined in section Testing the installation. No further patching is required.

1.3 Scope

This manual is intended for IT staff working at the Operating System level, and does not contain
information for end users or for application level administrators (workgroup administrators).

1.4 Skills required

Although the installation steps are described in detail, the installation process is largely a manual one
and not intended for the novice. To successfully install and configure the CARA integration, you should
be familiar with:

e Managing file and directory permissions

e Editing XML configuration files (using a generic text editor such as notepad or an XML-
specific editor)

e Documentum Server

e CARA (CARA Explorer, DQL and Control Panel)
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an ideagen product

1.5 Architecture diagram
This diagram shows the touch points between PleaseReview and CARA. The user interacts with the
CARA web application via the web browser. The web application displays certain PleaseReview
components within a frame in the CARA web app. This is seamless to the end user — as far as they are
concerned they are just viewing the information for a review within CARA.
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1.6 Supported Platforms an ideagen product

At present PleaseReview integrates with CARA 3.11.4.2 running on Documentum Server 7.1, 7.2, 7.3
and 16.4, with the respective Documentum Foundation Classes (DFC) 7.1, 7.2, 7.3 or 16.4. This must
be installed and functional before any further work is done.

The CARA integration has been tested running on the Apache TomCat Web Application server running
on Windows Server 2012 R2 (64-bit) and Windows Server 2019 Standard. If you require other platforms
to be supported, please contact support.

1.7 Supported Functionality

Some of the standard PleaseReview functionality is not available when used in conjunction with CARA
on Documentum Server and hence is not supported. Details of these can be found in section Appendix
A, along with details of any known limitations.
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2 Configuring the PleaseReview server an deagen product

2.1 Overview

When PleaseReview is integrated with CARA some configuration changes will be required to the
PleaseReview Documentum system connector configuration. This is required to make PleaseReview
work within the CARA document workflow.

2.2 Prerequisites
This section lists the software that must already be installed on the target system, and any specific
details regarding versions or configuration of that software.

2.2.1 CARA

All necessary required baseline PleaseReview DocBase configuration is completed within the CARA
Control Panel and that the interface must be fully operational before this installation is started.
Specifically confirm that:

e On the Data tab a Taxonomy called “Main Classification” exists

e On the Data tab a Dictionary with the name “Object Types” and alias of “en” exists, containing
an item with the Value of “*dm_document”, en of *"Document”

e For the “Main Classification” Taxonomy ensure its property Level 1 set to “"Object Types” and
that the item “dm_document (Document)” is available

e On the Categories tab a Category Definition exists with the following category details: Name of
"All Documents", Type of "dm_document”, Query of "1=1" and “All versions?” checkbox
checked.

e On the General tab under General Configuration, the “Enable manual linking and security”
checkbox is checked

e On the Classification tab a Classification Definition exists with the following properties: Defining
Taxonomy of “Main Classification”, Base_object_type of “dm_document”, Level_1_property of
“r_object_type”, Level_1_label of “Type” and all of the new document configuration types being
enabled with a Mandatory level of *1” and a Template mandatory level of “1”.

e A new dm_document (Document) of type Word has been added to the DocBase and the latest
version has subsequently been checked out edited and checked in as a new minor revision.

If any of the list configuration is not complete or the interface is not operational, please contact Generis
for advice on how to do so.

2.2.2 PleaseReview

The PleaseReview server itself must be fully operational before this installation is started. Specifically
confirm that:

e The PleaseReview Documentum System Connector is installed and operational.
e CARA users have been added to PleaseReview and can login.

e CARA users can add documents from CARA into a PleaseReview review using the PleaseReview
interface.
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2.3 Required configuration changes an ideagen product

Log onto the PleaseReview server and open the file Runtime/config/DCTMLogin.xml in a text editor.

2.3.1 Turn off major version check in

CARA requires that major revisions go through the CARA workflow and requires specific actions to be
performed before the document is promoted to a major revision. Although PleaseReview supports
major version check in it must not be used in this case.

In the <CheckinOptions> block remove the following sub-block

<CheckinOptions>
<CheckinMode>0</CheckinMode>
<Description>Check in as a major revision</Description>
<ExtraInfoPopup>../DocumentumSystemConnectoriWeb/Checkinlabel.
aspx</ExtralInfoPopup>
</CheckinOptions>

So the <CheckinOptions> block starts as follows:

<CheckinOptions>
<CheckinOptions>
<CheckinMode>1</CheckinMode>
<Description>Check in as a minor revision</Description>

2.3.2 Turn on default label for document upon check in

When PleaseReview checks a minor version into CARA it is possible to set the default check in label for
the version. To do this change:

<CheckinLabel></CheckinLabel>
To the desired value. For example
<CheckinLabel>Checked in from PleaseReview</CheckinLabel>

2.3.3 Turn on setting the document label to current if it is not yet approved

If a document is not “Approved” then when PleaseReview checks the document in the label "CURRENT"”
must also be added to the <CheckinLabel> above. If the document is “Approved” then the label
“CURRENT"” will not be applied and the last “Approved” version will be left as "CURRENT" instead. This is
done to meet the document promotion rules required by CARA.

This setting is not active by default and is required for the CARA integration. To turn it on change:
<SetCurrentIfNoLabel></SetCurrentIfNoLabel>
To

<SetCurrentIfNoLabel>Approved</SetCurrentIfNoLabel>

2.3.4 Turn on Review Inbox export

In order for details of review inbox items to be displayed in the Review SnapList within CARA, it is
necessary to send details as they occur in PleaseReview. To do this change the value

<ExportReviewInboxEnabled>false</ExportReviewInboxEnabled>

to

<ExportReviewInboxEnabled>true</ExportReviewInboxEnabled>
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2.3.5 Include Participant Details in CARA Inbox (Optional) an ideagen product

If desired, it is possible to include details of Review Participants in the PleaseReview snap lists
properties page. By default this is disabled as it causes a performance overhead where reviews have
large numbers of participants. Should however you wish to enable this feature, change the value

<ExportReviewIncludeParticipants>false</ExportReviewIncludeParticipants>
to

<ExportReviewIncludeParticipants>true</ExportReviewIncludeParticipants>

2.3.6 Turn off Embed Review User Setting

Turn off the Embed Review User Setting, as this feature isn’t available in the CARA integration. To do
this change the value

<EmbedReviewUserSetting>true</EmbedReviewUserSetting>
to

<EmbedReviewUserSetting>false</EmbedReviewUserSetting>

2.3.7 Restart the PleaseReview Services

For any configuration changes to take effect, the PleaseReview services (TaraWeb and TaraService)
must be restarted. This can be done from the menu within the AdminClient. Configuration changes will
NOT take effect until the services are restarted.
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3 Installing the CARA Integration an ideagen product

3.1 Things you will need to know

There are several configuration settings that will need to be specified during the installation. Some of
these are things you will need to find out and some are things you need to decide. This section lists
them up front so you can make sure you have all the necessary information to hand before you
proceed with the installation itself.

3.1.1 The URL of the PleaseReview server

You will need to know the location (URL) of the PleaseReview server. This is normally
http://servername/PleaseReview or just http://servername (if configured)

3.1.2 The groups of CARA users who will use PleaseReview

In order for the PleaseReview CARA integration to decide who will be permitted to see the PleaseReview
specific menu items and the PleaseReview inbox, a list of groups for those users will be required. It is
advisable that these groups are created as “locked” workgroups in PleaseReview after being created in
CARA. In this way, the members of the PleaseReview workgroup will automatically be synchronized with
the source CARA group by PleaseReview.

3.1.3 Locate the CARA webapps directory

All file system paths in this installation guide are relative to the location of the CARA web application.
This is normally

$CATALINA HOME%\webapps\cara

where % CATALINA _HOME% is where the Apache Tomcat application server is installed ($CATALINA
_HOME on Unix/Linux). From now on this directory will be referred to as \cara and all paths will be
relative to it.

3.2 Installing the software

3.2.1 Installing the files

Extract the provided zip file (PleaseReview_CARA_UI_xxx.zip) into a temporary directory. It will contain
the following folders:

CustomActions
Custom]SP
Dictionaries

DQL

Forms

Images

Styles
ViewConfigChanges

3.3 Creating DocBase objects

All of the tasks carried out in this section are carried out using DQL. To do this, log into CARA as an
Admin user with Superuser privileges and bring up the DQL window.

3.3.1 PR_REVIEW_TASK object

Open the file \DQL\create pr review task.txt in a text editor and copy each DQL statement into
the CARA DQL window and execute it.
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http://servername/

[0 Step not required [0 Step Completed [1 Step Failed

Date and Signature:

3.3.2 PleaseReview DocBase Roles

Now open the file \DQL\create PleaseReview roles.txt and copy each DQL statement into the
CARA DQL window and execute it.

5 W

This creates the roles “cara_pleasereview _owner”, “cara_pleasereview_participant” and
“cara_pleasereview_admin”, which are used to determine who will be permitted to see the PleaseReview
specific menu items and the PleaseReview inbox within CARA.

Please note, during PleaseReview upgrades only DQL statements relating to DocBase roles that don't
already exist will need to be executed.

[0 Step not required [0 Step Completed (1 Step Failed

Date and Signature:

3.3.3 Groups for locked workgroups

If you intend to create “locked” workgroups in PleaseReview, as recommended in section The groups of CARA
users who will use PleaseReview, these will be configured as sync’d workgroups in PleaseReview later.

The file \DQL\create example PleaseReview workgroup.txt provides an example of how to do
this for a group called “example_group”. For each group you wish to create, you will need to replace
each occurrence of the word “example” with the appropriate group name prefix (for example,
sales_group, support_group, etc.).

Each group created by the DQL script will have a base group and four sub groups. The sub groups
represent the roles the individual users will have within PleaseReview. When users are added to the
groups within Cara, they will be added to the group that represents their maximum PleaseReview role.
Non-admin users should only be added to one of the sub groups that is most applicable to them.

For example, if the base group is called “sales_group”, all of the users intended to only review
documents will be added to Cara group “sales_group_reviewers” while those users who may create
reviews and contribute to other reviews will be in “sales_group_author-contributor”. To add users with
admin roles, see section Validate new Administration functionality.

Each of the amended DQL statements should then be copied into the CARA DQL window and
executed.The DQL window can now be closed.

[0 Step not required [0 Step Completed [ Step Failed

Date and Signature:
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3.4 Installing the PleaseReview icons
Copy the files prlogo.png, prlogoadmin.png and prlogopdf.png from
\Images
to
\cara\images\icons\16x16.
Now copy the file prlogo32.png, prlogoadmin32.png and prlogopdf32.png from
\Images
To
\cara\images\icons\32x32.

Please note, this step will need to be repeated following any CARA upgrades being applied.

[0 Step not required [0 Step Completed 1 Step Failed

Date and Signature:

3.5 Installing the PleaseReview custom actions
3.5.1 Custom Code
Copy the folder and its contents from

\CustomJSP\pleasereview

Into

\cara\custom\pleasereview
This contains all the custom code, needed by the custom actions.

Please note, this step will need to be repeated during upgrades if directed in the release notes.

[0 Step not required 1 Step Completed [0 Step Failed

Date and Signature:

3.5.2 Custom Actions

Log into CARA as an Admin user with Superuser privileges, and open the Control Panel. On the
General tab, press the custom Actions button, which will open the Custom Actions form. You will
now need to import the seven PleaseReview specific Custom Actions, which reside in the folder
\CustomActions.

To import each custom action, press the Import button and then browse to the appropriate xml file for
the custom action to be imported, on the file selector. Pressing the Open button causes the custom
action to be imported, before closing the file selector and returning the Custom Actions form.

The custom actions that must be loaded are:

e Enter Review.xml
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My PleaseReview Settings.xml an ideagen product
New Review (with documents).xml

New Review (without documents).xml

New Review as PDF (with documents).xml

Review Control Panel.xml

Review Distribution Lists.xml

View Report.xml

Workgroup Management.xml

Finally press the close to shut down the Custom Actions form.

Keep the control Panel open, as will be needed in the following task.

[0 Step not required 1 Step Completed 1 Step Failed

Date and Signature:

3.6 Installing the PleaseReview dictionaries

3.6.1 PleaseReviewConfigSettings

On the Data tab of the Control Panel, press the Dictionaries button, which will open the
Dictionary Manager form. You will now need to import and configure the
PleaseReviewConfigSettings dictionary.

To import the dictionary, press the Import button and then on the file selector, browse to the file
\Dictionaries\PleaseReviewConfigSettings.xml. Now press the 0pen button to import the
dictionary, close the file selector and return the bDictionary Manager form.

Now update the PleaseReview configuration settings for your environment. To do this select
PleaseReviewConfigSettings inthe Dictionary Manager form and then press Edit. The below

screen will appear:

Dictionary: PleaseReviewConfigSettings -3
Search: | |x |
Active? Value o Setting Code Description
PleaseReviewBasslURL The base URL for the —

corresponding instance of
PleaseReview {e.0.
https:\kldev.pleasetech.ne..

Version 6.4.4 The release number of the
FleaseReview CARA
Component
(® rdd ¢ Edit T Remove B | Export to... = Import DO Populate with DQL
Save Close
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Next highlight the value PleaseReviewBaseURL and press Edit. In the setting Code field enter
the base URL value for your PleaseReview instance, as discussed in section. Please note this URL
value MUST NOT end with a‘/’ character.

For example:
7/ Dictionary: PleaseReviewConfigSettings =l
Search: l | X I
Active? Value « Setting Code Descripticn
] PleaseReviewBaseURL The base URL for the
corresponding instance of
PleaseReview (e.q.
htne:\kldewv nleacsterh ne
@] Version Edit dictionary item
Value™: l PleaseReviewBaseURL |
@ add & edr [y SeLting Code™ !bm://vour-wmuanmﬂgasgmgweﬂ |
Description™: lThe base URL for the corresponding instance of PIeaseRe\I

H Save m Cancel

Now press save and Save again to return to the Dictionary Manager form.

[0 Step not required 1 Step Completed ] Step Failed

Date and Signature:

3.6.2 Object Types

Whilst still in the Dictionary Manager form, it is now necessary to add a new object type for the

pr review task object created in section PR_REVIEW_TASK object. To do this select Object Type on the
DictionaryManager form, so that it becomes highlighted and then press Edit. The below screen will

appear:
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Dictionary: Object Type (=[]
Active? Value « en
dm_document Document
dm_sysobject Sysobject
@ Add & Edit Ti] Remove M6 | Export to... = |4 Import DO Populate with DQL
U Save Close

Now press Add, and enter the following values, as shown below:

e Value: pr_review_task
e en: Review *

Dictionary: Object Type ([ ¢]
Active? WValue « en
dm_document Document

dnf Mew dictionary item

@ add & 8| en*: |Re-.riew | with DQL

Value*: | pr_review_task| |

lose

H Saveuﬂmm Cancel

oo

* - The value en, may differ based upon your personal local settings. Please adjust accordingly.

Next press save and Save again to return to the Dictionary Manager form, followed by close. You
should now be back on the control Panel ready for the next step.

[0 Step not required [1 Step Completed [1 Step Failed

Date and Signature:
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3.7 Installing the PleaseReview forms an ideagen product

3.7.1 pr_review_task Form

Select the General tab of the Control Panel, press the Forms button, as shown below. Please note -
If the Forms button doesn't exist on the General tab, you will temporarily need to enable it. This is
controlled under User Capabilities, inthe Configuration section. The Forms entry must be
ticked for it to appear. This tick-box, should be returned to its initial value once this step is completed.

& Control Panel [=)lx]

u General || Data || Lifecycles || Classification | Categories || Administration | Export/Import |

7 A

Custom Actions Dashboard Management Document Types Config
= | B 4
Folder Types Config Forms @ General Configuration
Mail Configuration Periodic Task Definitions Relation Types
Sequences Task Types User Capabilities

&2

View Management

The Forms page will open (as shown below), on which you will now need to create a form configuration
forthe pr review task object, before importing the form, as per the following instructions.

Configuration for « User or Group Mewrimport View/Edit Medify Date

LV pP_Wdislmdlir AllUSErs ] ] SJUL U, S0 1S U 1222 Al -
dm_cabinet All Users Jul 10, 2014 10:13:32 AM
dm_folder All Users Jul 10, 2014 10:13:32 AM
dm_job All Users Jul 10, 2014 10:13:32 AM
dm_method All Users Jul 10, 2014 10:13:32 AM I
dm_sysobject All Users Jul 10,2014 10:13:32 AM - -

S

Press the Add button, and a form will be displayed as shown below:
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[ ['E] Hew form E]
Please select user or group to which this configuration applies
and one or both of the Mew Import & View Edit Options.
Please also enter 3 Configuration Name and select the Base
Object Type.

User or group™: | lUsers |v |
All Users

Selected user or group: | |v |
Mewr and Import Properties
View and Edit Properties

Base object type™: | pr_review_fask | i |

Configuration name™*: | pr_review_fask |

o sae |[@ cancel |

All the default values should be used except for the Base object type for which you should select
the value pr review task. Next press save, which will display the following blank Forms page:

I:__|_=_:| Form: All Users - New Import View Edit (pr_review_task) E]@
|:'_|':':| Form
Add - Edit Move up Move down Remove
IEI Save @ m Cancel

Page 18

t: +44 1629 699 100 | e : info@ideagen.com | w : ideagen.com

S an ideagen product Copyright © 2021 Ideagen plc



mailto:info@ideagen.com

Press save again which will close this page and return you to the
Forms page, as shown:

i:F | Forms - |

Configuration for = User or Group New/Import View/Edit Moedify Date

UIT_LdineL Al UsSEls ¥ L] AU U, 20T T L L A -
dm_folder All Users Jul 10, 2014 10:13:32 AM
dm_job All Users Jul 10, 2014 10:13:32 AM
dm_method All Users Jul 10, 2014 10:13:32 AM
dm_sysochject All Users Jul 10, 2014 10:13:32 AM D
pr_review_task All Users Oct 15, 2014 3:46:57 PM +

| #dd || Edt || Remove || Dupicate || Che:k-in..®| Export |
Close

Now select the entry pr review task and press the Check-in.. button. In the file browser, navigate
to and select the file \Forms\A11l Users - New Import View Edit (pr review task).xml and
press open. The form will then load.

You can now close the Forms page, and return to the Control Panel ready for the next step.

[0 Step not required [0 Step Completed (1 Step Failed

Date and Signature:

3.8 Installing the PleaseReview custom configuration

3.8.1 Export Existing CARA Configuration

As some of the PleaseReview configuration changes involve updating your existing CARA configuration,
it will first of all be necessary to export details of what you currently have.

On the control Panel go tothe Export/Import tab, pressthe Configuration export button.
You will be prompted to specify a location into which to save the export file. The default filename will
look something like backup CARAPROD 10-8-18 4 19 PM.zip. Rename this to replace the *backup_’
prefix with ‘pleaseReview_’, so it now becomes pleaseReview CARAPROD 10-8-18 4 19 PM.zip.
Press the save button to export the configuration to the backup file.

Also, take a copy of this backup file and store it somewhere safe, in case you should ever wish to back
out the PleaseReview configuration changes.

[0 Step not required [0 Step Completed [1 Step Failed

Date and Signature:
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3.8.2 Addlng View SnapLists an ideagen product

The custom PleaseReview items should be located within one or more views within your CARA
environment, for views that are associated with an object type of dm document and against a view
which is visible. The custom change involves the addition of two new review SnaplLists called ‘My
Reviews’ and ‘Recycle bin’.

For each of the views in your environment in which you wish these items to appear, all of the changes
outlined in this section will need to be made. Please note that all of the examples shown below are
applied to the default view, for which the configuration details are contained in the file
\Views\Default.xml.

First unzip the export zip file created in section Export Existing CARA Configuration,

pleaseReview CARAPROD 10-8-18 4 19 PM.zip would unzip to the directory
pleaseReview CARAPROD 10-8-18 4 19 PM. From now onthis directory will be referred to as
\backup and all paths will be relative to it.

Open the file in \backup\Views\Default.xml in a text editor for editing.

3.8.2.1 SnaplLists

Look for the section containing the XML SnapList tags, which contain details of all the SnapLists used in
your view, as shown below:

<snapLists>

</snapLists>

All of the SnaplLists used in your view will be contained between these tags with each SnapList being
contained within its own <snapList> tags. The order the entries are displayed in the file relates to the
order they are listed in your view.

Now open the file \ViewConfigChanges\PleaseReviewSnapLists.xml and copy the entire
contents between the <snapLists> tags in the appropriate place.

This section should now look something like:

<snapLists>
<snapList path="PleaseReview" label="My Reviews" icon="prlogo.png">
<objectType>pr review task</objectType>
<allVersions>false</allVersions>
<query> inbox owner ref=USER and deleted review='0' and
(lower (review title) like '%${filter}$%' or lower(review id) like '%${filter}%s"')

and (my status != 'Review Owner' or parent review id = '-1')</query>
<columns>
<column>

<alignment>left</alignment>
<label>Due Date</label>
<name>due date</name>
<sortByAlias>false</sortByAlias>
<sortable>true</sortable>
<visible>true</visible>
<width>150</width>

</column>

<column>
<alignment>left</alignment>
<label>Review Title</label>
<name>review_title</name>
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<sortByAlias>false</sortByAlias> an ideagen product
<sortable>true</sortable>
<visible>true</visible>
<width>200</width>
</column>

</snapList>
<snapList path="PleaseReview" label="Recycle bin" icon="bin.png">
<objectType>pr review task</objectType>
<allVersions>false</allVersions>
<query> inbox owner ref=USER and deleted review='l' and
(lower (review_title) like '%${filter}$%' or lower (review id) like '%${filter}%"')

and (my_ status != 'Review Owner' or parent review id = '-1')</query>
<columns>
<column>

<alignment>left</alignment>
<label>Due Date</label>
<name>due date</name>
<sortByAlias>false</sortByAlias>
<sortable>true</sortable>
<visible>true</visible>
<width>150</width>

</column>

</snapList>
<snapList path="PleaseReview" label="All Reviews (Admin)"
icon="bin.png">
<objectType>pr review task</objectType>
<allVersions>false</allVersions>
<query> (lower (review title) like '$${filter}%' or lower (review id)
like '%${filter}%') and my status = 'Review Owner'</query>
<columns>
<column>
<alignment>left</alignment>
<label>Due Date</label>
<name>due date</name>
<sortByAlias>false</sortByAlias>
<sortable>true</sortable>
<visible>true</visible>
<width>150</width>
</column>

</snapList>
</snapLists>
Now save and close the view file.

3.8.3 Reimporting PleaseReview Configuration into CARA
Now the configuration changes have been made, the next step is to create an import file. To do this zip

the contents of the updated export folder. For example folder pleaseReview CARAPROD 10-8-18
4 19 pM would be zipped into a file called pleaseReview CARAPROD 10-8-18 4 19 PM.zip.
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Next you will need to import the configuration data into CARA. To do an ideagen product
this, go to the Export/Import tab of the CARA Control Panel and press the Configuration

import button. Now select the file pleaseReview CARAPROD 10-8-18 4 19 PM.zip thatyou have

just created and press the configuration import button. Once the import completes you will be

asked to specify the name of a file to write the import report to. Just select the suggested filename and
press Save.

The configuration import is now complete. Stay in the Control Panel ready for the next step.

[J Step not required [0 Step Completed (] Step Failed

Date and Signature:

3.9 Adding Menu Actions

For each of the views in your environment against which review SnapLists were created in section Adding
View Snaplists. As before, all of the examples shown below are applied to the default view.

On the CARA Control Panel go to the General tab, press the view Management button. From the
list of available views, select the desired one and press Edit, as shown below:

A control Panel (=) ]

[ General ” Data H Classification ” Categories ” Administration H Export/Import

v &

Custom Actif £ Views: CARADEV (=[]

Document view: Admin [Sysobject)
Default

Folder Types

&

Mail Configurs

¥

Sequence|

Add Duplicate Edit J|'n] Remove Close

—
— -
i

View Management
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The following screen will be displayed: an ideagen product
Edit view: Default (= [2¢]
View name™*: | Default |
Type™: |dm_dacument |v|
[ For form uszge only/hidden in Explorer
Columns Dizlog settings Dimensions
Y @
Filters In-tray/Inbox Menu
Mew item shortcuts Properties Row styles
Q a8 X
s
Search config Security Settings
11 —
e = N
Snaplists Toolbar Widgets
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3.9.1 Menu an ideagen product

On the Edit view page, press the Menu button, to open the Menu page. Now press the Add actions
button below the Custom document context menu section, as shown below:

'EZ Menu ES

Custom document context
menu:

Add actions  Add separator  Remowe

Custom folder context S
menu:

Add actions  Add separator | Remowve

The Select actions page will appear. Scroll down to the bottom right of the page to the Custom Actions
section and check the items:

e Enter Review

e New Review (with documents)

e New Review (without documents)

e New Review as PDF (with documents)
e Review Control Panel

e View Report
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as shown below:

Select actions [ ][]
— Custom Actions -
|| Enter Review

|| My PleaseReview Settings

Mew Review (with documents)

Mew Review (without documents)

¥ Mew Review as PDF (with documents)
Review Control Panel

|| Review Distribution Lists

View Report

O Waorkgroup Management I

| | ||

I save El cancel

Next press save and save again to return to the Edit view page.

[0 Step not required [0 Step Completed ] Step Failed

Date and Signature:

an ideagen product
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3.9.2 Toolbar an ideagen product

Next, press the Toolbar button on the on the Edit view page, to open the Toolbar page. Now
press the Add actions button, as shown below:

EZ Toolbar (=]

Options: |#| Display labels

¥ Display in two rows

Custom toolbar:

Add actions  Add separator  Remove

El Save m Cancel

The Select actions page will appear. Scroll down to the bottom right of the page to the Custom Actions
section and check the items:

e My PleaseReview Settings

e New Review (with documents)

e New Review as PDF (with documents)
e Review Distribution Lists

e Workgroup Management

as shown below:

Selectactions e
_t ll'jIIIII ﬁm‘ ry
|| Enter Review

I¥| My PleaseReview Settings

|#| New Review (with documents)

|| New Review (without documents)

[ New Review as PDF (with documents)
|| Review Control Panel

I¥| Review Distribution Lists

|| View Report

¥ Workgroup Management I

& save El cancel
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Next press save and Save again to return to the Edit view page.
Then press save again to return to the views page, clicking No on the confirmation page.

Now click close return to the Control Panel

All the configuration changes have now been made and as a result the Control Panel can now be
closed.

[0 Step not required [0 Step Completed 1 Step Failed

Date and Signature:

3.9.3 Recycle CARA Web Server
Recycle the CARA webserver to ensure all the changes applied in this section take effect.

[0 Step not required [0 Step Completed (1 Step Failed

Date and Signature:

3.9.4 Configuring the PleaseReview email templates

When a user in PleaseReview does certain actions, emails may be sent to interested parties (usually the
review participants). These emails contain a hyperlink which directs users back into the main
PleaseReview interface, which is not normally desirable when PleaseReview is integrated with the CARA
user interface.

The PleaseReview CARA integration includes additional email templates that provide the user with a
link into CARA rather than directly into PleaseReview.

The actions below need to be performed on the PleaseReview server as it sends these emails, not the
CARA server. The Runtime directory is a sub-directory of the location where PleaseReview is installed.

To install these special email templates, do the following:

e Locate the directory Runtime/config/EmailTemplates in the PleaseReview installation directory.

e Copy the contents of the folder /EmailTemplates/Documentum.cara to
/EmailTemplates/Documentum, overwriting any files which already exist. There should now be
a directory called EmailTemplates/Documentum inside PleaseReview.

e Rename the file EmailTemplates/Documentum/caraurl.xsl.template to
EmailTemplates/Documentum/caraurl.xsl if it doesn't already exist. Then edit the
Runtime/config/EmailTemplates/Documentum/caraurl.xsl and replace [[CaraURL]] with the root
part of the URL the users use to access CARA.

For example (on a CARA server using Apache Tomcat, with a docbase called ‘'TEST’) it would be
something like http://CARA:8080/cara/#TEST %5BDefault%5D - note that the "%5BDefault%5D"
must be included and there must not be a / character on the end of the URL. E.g.

<xsl:variable
name="caraurl">http://CARA:8080/cara/#TEST%$5BDefault%$5D</xsl:variable>
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Any user using PleaseReview and authenticated by CARA using their
Documentum credentials will see these emails, but users who are not authenticated by CARA will see
the standard emails that will return then into the standard PleaseReview user interface.

[0 Step not required [0 Step Completed [1 Step Failed

Date and Signature:

3.9.5 Applying CARA Theme in PleaseReview Screens

If you are using the default Gray Theme within CARA this step is not required, as the PleaseReview
screens default to gray also. If however you wish to apply the B1ue Theme then the following will need
to be done.

Locate the directory TaraWeb/Styles/documentum in the PleaseReview installation directory. In that
folder, replace the file tara.css with the file /Styles/Blue Theme/tara.css from the unpacked zip
file

Please note that for any future updates to PleaseReview, this step will need to be repeated.

[0 Step not required [0 Step Completed 1 Step Failed

Date and Signature:

3.9.6 Recycle Tara Service

Recycle the PleaseReview TaraService and TaraWeb application pool, in order to ensure all of the
changes applied in section Required configuration changes, and section Configuring the
PleaseReview email templates take effect.

[0 Step not required [0 Step Completed [1 Step Failed

Date and Signature:
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3.10 Testing the installation an ideagen product

This test will involve creating a test review from within the CARA UI and checking it is then displayed in
the My Reviews SnaplList correctly.

3.10.1 Sync Test User into PleaseReview

For this pick a user who is a member of one of the groups defined earlier (see section Groups for locked
workgroups). This usermust have author permissions within PleaseReview and hence must have been
sync’d into a suitable group within PleaseReview. For example, if you had called your workgroup
“sales_group”, as in the example in section Groups for locked workgroups, you would need to assign
them to the documentum group “sales_group_author” to ensure they have author permissions within
PleaseReview.

The group “sales_group” would then need to be re-sync’d within PleaseReview. Remember that no
other sub groups should be synchronized to PleaseReview, only the base group.

3.10.2 Set Test User Permissions

What PleaseReview items (toolbars, SnapLists and action menu items) a user will see in CARA are
controlled by whether the users are assigned to the “cara_pleasereview_owner”,
“cara_pleasereview_participant” and “cara_pleasereview_admin” roles within CARA.

As the test user is an Author they will need to be assigned to the role “cara_pleasereview_owner” as this
will give them the ability to see the New Review buttons within CARA. This should be done nowusing
an admin account.

Please note, that until a user has been sync’d into PleaseReview as discussed in section Sync Test User
into PleaseReview, they will not be able to use the PleaseReview functionality within CARA. As a result
it is not recommended to assign the users either “cara pleasereview _owner” or
“cara_pleasereview_participant” roles until after the sync has occurred.

In addition this user should be given VERSION permission within CARA, as they will need this in order to
be able to check any documents reviewed in PleaseReview back into CARA.

3.10.3 Create New Review

Log into CARA as the test author user. Please note, this user must also be able to log in to
PleaseReview as well, using their Documentum credentials.

First browse to a cabinet in the CARA interface and select a Word document that you have version
permission on so that it is highlighted. Now press the “New Review” button in the toolbar menu as
shown below, which will launch the PleaseReview New Review creation wizard. You should not be
asked to log in to PleaseReview at this point because you will have been automatically authenticated to
PleaseReview via Documentum.

coroé [ @ pocrepokraken16x « 1 Explore [ My WidgetSpace X Control Panel
File v Edit v View v Tasks v Workflows v Tools v Settings v Help v Document view: | Default
[ Create Document |4 Import Document | (g Properties [ bump A permissions @ view @, view POF ¢ Ediit [T3 check-out W pelete... @ Add task
() New Structure.. &4, Add relationship ¢ Relationship Manager Q Search oot DQL APt APT <> Script Editor ‘9§ My PleaseReview Settings () New Reviev[vhnc-l New Review as PDF (with docum
]
Navigation [« | Please Review
Search: H ‘ |P‘x, 4 sync A Goup -»:,l Carousel =] List =¥ Thumbnails |8 | Export to... ~ Search in folder: Plx
== e - Name « Version Object Type ACL Name Creation Date
- Lim Teng Wee
= D ﬁ] Sample policy document 0.1, CURRENT dm_document dm_4500001080016d0c 7/1/21,11:44 A
v E i Wan -
Please Review
| postman
| Resources
b [ System
il =
Y Globai itters x|¥]
B CURRENT Only <« I—— >
| DocRepoKraken16x | 14 4 [pagdt  Jof1| b bi | |1tems perpage: 20 50 100 Displaying 1-10f 1
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Follow the PleaseReview review creation wizard through as normal. Once the wizard is complete, start
the review and then close the New Review wizard pane.

3.10.4 Validate Review SnaplList entry

In the CARA Navigation Pane, on the left-hand pane, expand out the SnapLists and select PleaseReview.
The sub sections of "My Reviews” and “Recycle bin” will appear. Double click on “*My Reviews"” and check
the “PleaseReview inbox” appears showing the review you just created in the previous step. Select the

review, and then right click selecting “Enter Review”, as shown below:

coé [ e ocrepokrakentéx + 0 explore. [X] my widgetspace ¥ Contol Panel 2
File v Edit v View v Tasks v Workflows v Tools v Settings v Help » Doumentwew[Default |v
ﬂ Create Document (: Import Document i
Pro
@ New Stucture... I gt 4
@ Dump

Navigation « My Reviews & pemissions «
search: [ 11 19[x] || 4 sy & Goup || etalls it Carousel =] List &% Thumbrais |B) Export to. v By checicout 19]x]
b (L) My Desk “ || 7 Review status 7 My tatus + | 'Y Apply fiters B ekt
417 Cabinets — - i — @ add task

i | ‘:‘Eznxah;:tsm REV.EW T::e x ‘I:wmgm id g [WWWWW

b 1 dmadmin BLic. o RS Send a5 URL.. s

I | DocRepoKraken16x (g Add to favorites

| Lim Teng Wee )
, & Add to others Favorites
11 Loo Lai Wan )
© Please Review E Enter Review

» Ml poen O Newreren g |
0 Resources d K Review Control panel . |
DocRepokraken16x M4 lpagdt i1l b M [ | ems per page: 20 50 100 £ View Repot E’playingl-lofl
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The Review should open in the standard PleaseReview interface, at an ideagen product

which point you should again not be prompted to log in. Now close the review window by pressing the
“leave the review” button and log out of CARA.

[1 Step not required [1 Step Completed [1 Step Failed

Date and Signature:

3.10.5 Validate new Administration functionality
PleaseReview 6.1.6 and above introduces two new Administration features that are available to users
with the correct permissions. The functionality allows Administrators to:

e Edit the participants and owners (through Review Transfer) of reviews owned by any users

e Edit the members of PleaseReview Workgroups

Access to this functionality requires the users to be in specific groups within CARA and to have
PleaseReview permissions set manually.

3.10.5.1 Grant appropriate privileges and permissions

To make the Administration functionality accessible to a user, log into CARA as an Admin user with
Superuser privileges, and open the Control Panel.Onthe Administration tab, pressthe Groups
button, which will open the Group management form.

caraé

dmadmin @ DocRepoKraken16x ~ o Explore [X] My Widgetspace X Control Panel P

File ~ Edit = View ~ Tasks ~ Workflows ~ Tools = Settings ~ Help ~ Document view:| Default |V
Create Document Import Documen x’;o | Panel %

Mew Structure...
Q ‘ General H Data ” Lifecycles ” Tasks | Classification ” Categories H Administration H Export/{Import
Navigation ‘ ‘g ‘ «
search: [} dilder| [P[x]
- /Q\ My Deck Groups Job Management Logs
I+ ¥, Cabinets
[+ [ Dimensions E ‘
I % Snaplists Object Types System Lock Users
3 Staging Area

Global Filters
Y Search: || |V‘x| Close
CURRENT Orly — ,
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e s (=]x] an ideagen product
Search: | |P | X |
| Name « | Description Owner |
a admingroup dmadmin =
'y cara_cancel_checkout_managers dmadmin
a cara_config_managers dmadmin
& cara_consumer Consumer dmiadmin
& cara_contributor Contributor dmadmin
‘ cara_pleasereview_admin User who can perform PleaseReview admin tasks dmadmin
from within CARA
& cara_pleasereview_owner User who can create and manage PleaseReview  dmadmin
reviews from within CARA
‘ cara_pleasersview_participant User who can participate in PlzaseRevi Imadmi
reviews from within CARA
‘ cara_power_user Power user dmadmin
& cara_structure_creators dmadmin
a cara_task_managers dmadmin
'y cara_template_managers dmadmin
‘ dce_create_room_groups User who can create groups in rooms dmadmin
‘ dce_datatable_creator dmadmin
2 dce_hidden_users Members in this role will not be visible to other  dmadmin
users,
_‘_ dce_room_creator User who can create rooms dmadmin 7
[4 4 |pagell _ Jofa| b M | & Displaying 1 - 20 of 78
Add Edit Delete Close

You will now need to add your user(s) to the cara pleasereview admin role and, if you also
require these users to be able to create or participate in reviews, the cara _pleasereview owner
role or if you require them to just participate in reviews, the cara pleasereview participant

role.

‘ Edit role: cara_pleasereview_participant IE‘
Mame™: cara_pleasereview_participant |
Description: User who can participate in PleaseReview reviews

from within CARA
Class*: [role I~]
Email Address: | [E|
Owner™: | dmadmin |" |
Administrator: | |V | x |
[ private
[ Dynamic
(@) Treat users as members
() Treat users as non-members
User Members: Test Userl -
Test User3
Test Userd
Test UserS
testcontributor ~
Group Members: prcaral6x_group_contributor E
prearalox_group_reviewer

|%| Save m Cancel
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In section Groups for locked workgroups, you will have created a set of groups for your an ideagen product
PleaseReview users. If you have previously added your intended administration user(s) to any of these
groups, please remove them.

Finally, add your user(s) to the top level group. So, for example, if the top level group is called
“sales_group”, add your administration user(s) to this group.

All the CARA based configuration changes have now been made and as a result the Control Panel
can now be closed.

You should now log onto the PleaseReview system as an administrative user and re-sync the group
“sales_group” (from the example). Remember that no other sub groups should be synchronized to
PleaseReview, only the top level group.

As you have added your administration user(s) to the top level group, those user(s) will NOT be granted
any PleaseReview privileges, other than the default. You will need to make these grants manually,
ensuring the users have one of the Admin privileges — for example, Admin only.

If you also require these users to be able to create or participate in reviews, they will need one of the
extended privileges — for example Admin-Author-Contributor.

3.10.5.2 How to access the new Administration functionality
At this point, the new administration functionality will be accessible to the users specified.

To begin, login to CARA as one of the administrative users.

To administer workgroups, press the “Workgroup Administration” button on the CARA toolbar:

=
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This will open up the Workgroup Management screen: an ideagen product

& Workgroup Administration x|
orkgroup management

oot » prcarabx_group (ID:100)

sub workgroups
WORKGROUP ID WORKGROUP NAME NOTES ALL MONITORS
Review Types Settings Edit Copy Emails Delete

To Administer other users’ reviews, find the reviews in the new “All Reviews (Admin)” SnapList:

45 Snaplits
b 5 Admin
4 PleaseReviw
b () My Reviews
) ] Recyce i
4 Al Revies (i
) 7 Workgroups
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Use the “Review Control Panel” option from the right click menu to an ideagen product
open the control panel where the review can be edited:

coraé I ¢ vocrepoKrakentsx -
File > Edit~ View~ Tasks > Workflows~ Tools > Settings > Help ¥
E} Create Document. }}; Import Document ’ Properties Dump. & Permissions Bﬁ Check-Out m Delete... Q Add task Q Task Manager ’] Add rendition d Add rhaﬁonshin
@ tew Structure. . & Relationship Manager Q Search oat DQL AP AP <> Script Editor 5§ My jew Settings & jew Distribution Lists & inistrati ‘
i
Navigation « | My Reviews
searc: [ < sy & Goup [0l 5 Carusel [£] st [ Thumbrais | ) Exortt.. -
b ) My Desk T Review Status ~ 7 My Status + | 'Y Apply fiters
4 77 Cabinets
Kl ik | DueDate ' Review Title | Owner | Review Status My Status | Workgroup
> Wil dmadiic [] 72121, 11:95 oM Sanity Test Chris In Progress Review Oviner prearal6x_group
b 1 DoRepokrakentéx Review Control Panel B
7 Lim Teng Wee % =
b 1 Loo Laian review control panel - Sanity Test
1 Please Review
b [ postman . .
L i Sanity Test (id 213)
b 1 System
b i Temp REVIEW STATUS In Progress (Due: 2 Jul 2021 11:45 PM; Started: 1 Jul 2021 11:51 AM) Extend deadline
b [ Templates
b [ Test User
b - Dimensions L
Wit participants
b 5 Admin
4 = PleaseReview NAME STATUS ROLE SUMMARY cc
4 () My Reviews
b 'SP Workgroups Chris Review Owner Owner 0
» @) Recycle bin
> QA Reviews (Admin) Test User1 Not Started Reviewer 0
I g Staging Area
comment summary
DOCUMENT OPEN ACCEPTED MERGED CLOSED WITHDRAWN
@ Sample policy documentggly 0 0 0 0 0
[ Email Status ” Edit Details ]l Delete Review ] [ Clone As A New Review
l Status ” Download copy l [ Notify ] l Copy Emails l
N
L& Close
DocRepoKraken16x 14 4 [pageT__Jof1| b M [ |items perpage: 20 50 100
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4.1 Features Not Supported

This section lists any PleaseReview features, which are not supported when using PleaseReview in
conjunction with CARA on Documentum Server:

n” I\

e The PleaseReview groups “admin only”, “*monitor only”, “reviewer-delegator” and “contributor-
delegator”, should not be assigned to CARA users.

e Itis not possible to embed the actual document review interface within the CARA application; it
can only be used as a “pop-out” new window.

e The profile tab of the ‘My settings’ screen is not displayed in CARA integrations as the data
displayed on this screen is not relevant.

4.2 Known Limitations

This section lists any known limitations of using PleaseReview via the CARA UI. Where appropriate,
details of suitable workarounds are shown as well.

e Unlike in the native PleaseReview interface, participants with “Viewer” role will have access to
the “View Report” screen via the custom action.

e When items within the PleaseReview inbox items are updated within PleaseReview, these aren't
automatically reflected within the current page within CARA. For instance if a new review were
created or had its status changed, in order for this to be reflected in the "My Reviews” SnapList
the user would need to double click on it so that a refresh takes place.

The same thing may happen with the “Recycle bin” SnapList.

Should on occasion an error occurs due to the item having changed state, users should be
trained to go close the error window and perform a refresh from within Cara.

e In order to be able to access the PleaseReview windows from within the CARA UI when using
Internet Explorer, you may have to add the PleaseReview base site URL (e.g. https://your-
company.pleasereview.net) as a “trusted site”.

o If a user exists as an author in one or more than workgroup, they will need to be assigned to
the cara pleasereview owner role which will in turn give them access to the menu itemsto
be able to create a ‘New Review’. Should they also exist as a reviewer only member of
another second workgroup they will still be able to select the option to create a review in this
second workgroup, however in doing so they will encounter a permissions error. In order to
avoid this, users should be trained only select workgroups they have permission on.

e Authors can only create (checkout) reviews on documents they have version permission on.

e When transferring reviews, the new owner must have version permission on all the documents
in the review, otherwise any subsequent check-ins will fail. As a result users should be trained
to be aware of this.

e If a user manually checks in a document they currently have in review, it will not be possible for
the system to automatically check the review document back into CARA from the review
Closeout screen. Instead the user would need to manually save the document with review
changes locally and then manually check it in as a new version.
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e If a user is assigned to the cara pleasereview owner an ideagen product
role, which will also give them access to the Admin functionality, they must also exist in
PleaseReview as a user with Admin permissions.

e Inthe PleaseReview SnapList, the "New Review"” button will not appear if the SnapList is empty
(i.e. if the user is not a participant in any reviews). In this case, the user can only initiate a new
review from the cabinets section of CARA.

e Wildcard searches using * aren't supported through the CARA UI in the same way as within
PleaseReview. Instead no wildcards are needed in accordance with standard CARA
functionality.

e The PleaseReview SnapLists only work in detailed view.
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All trade names, trademarks, and service marks are the rightful property of their respective Owners.
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